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About this Manual

This manual gives instructions on how to set up and use your Nanosurf
easyScan 2 STM system. Installing the easyScan 2 STM should be read when
installing your easyScan 2 STM system. The chapters Preparing for Meas-
urement and First Measurements should be read by all users, because they
contain useful instructions for everyday measurements. The chapter STM
Theory gives some general information on the scanning tunneling micros-
copy technique and its implementation in the easyScan 2 STM. The other
chapters give more information for advanced or interested users. Those
who need a more detailed description of the functions of the easyScan 2
software should refer to the Software Reference manual.



The easyScan 2 STM

The Nanosurf easyScan 2 STM was designed to allow people without train-
ing as a physicist to do experiments in the world of atoms. Its design is
compact, simple and comfortable to operate. With the easyScan 2 STM, it
is possible to do any STM experiment which can be carried out in air. The
sample approach system allows simple handling of samples and tips, whilst
at the same time providing maximum stability of the tip-sample distance.
All functions can be carried out using a computer and the easyScan 2 soft-
ware.

The easyScan 2 STM system is a modular scanning probe system that can
be upgraded to obtain more measurement capabilities. The main parts of
the basic system are the easyScan 2 STM scan head, the Vibration Isolation
Platform, the easyScan 2 Controller, and the easyScan 2 software. At the
time of publication, the following parts can be used with the easyScan 2
system:

e AFM Scan Heads and modules used for AFM operation: can also make
measurements on non-conducting samples. Refer to the easyScan 2 AFM
Operating Instructions for more details.

« Signal Modules: allow monitoring signals (Module: S) and creating cus-
tom measurement modes (Module: A). Refer to chapter The Signal Mod-
ules (p.52) for more details.

» Nanosurf Report: software for detailed measurement analysis and auto-
matic report generation.

« Scripting Interface: software for automating measurements. Refer to the
Software Reference and Programmers Reference for more details.

» TS-150 active vibration isolation table: reduces the sensitivity of the
instrument to vibrations in its environment.



THE EASYSCAN 2 STM

Features

easyScan 2 Controller

Electronics
Electronics size / weight
Power supply
Computer interface
Integrated USB hub
Measurement channels

Scan generator

Scan speed

Scan drive signals

Scan area and data points

Scan image rotation
Sample tilt compensation
Spectroscopy modes

Spectroscopy measurement
averaging
Spectroscopy data points

Software
Simultaneous display of
data in charts types
User profiles

On-line processing func-
tions

Quick evaluation functions

Data export

470 x 120 x 80mm / 2.4kg
90 - 240V~/ 30W 50/60Hz
USB 1.1

2 Ports (100mA max)

16bit A/D converters, up to seven signals
depending on mode.

16bit D/A converter for all axes

Up to 60ms/line at 128 data points/line

No (dangerous) high voltage

Individual width/height, up to 2048 x 2048
points

0 - 360°

Hardware X/Y-slope compensation

Single point measurement or multiple meas-
urements along vector

1-255

Up to 2048

Line graph, Color map, 3D view, ...

Customisable display and parameter settings
Mean fit, Polynomial fit, Derived data, ...

distance, angle, cross section, roughness...
BMP, ASCII, CSV, ...



FEATURES

Computer requirements

Operating system Windows 2000, XP or newer
Electronics interface USB port

Recommended PC hard-  Pentium 4/M or AMD Athlon, 256 MB
ware RAM, True color 1024x786 video card,

HW Open GL accelerator
Computer not included with system.

Nanosurf easyScan 2 Scripting Interface

Applications Automating measurement tasks, lithogra-
phy, custom evaluation functions, using
third party measurement equipment

Included control software  Windows Scripting Host: Visual Basic
Script, Java Script, ...

Remote control by COM compatible languages: LabView,
MathLab, Visual Basic, Delphi, C++, ...

Nanosurf easyScan 2 Signal Module: S

Available output signals X-Axis, Y-Axis, Z-Axis, Approach, Tip Volt-
age, STM Current or AFM Deflection,
Excitation, Amplitude, Phase

Full scale corresponds to +10V, Excitation: +5V
Power supply output GND, +15V, -15V

Nanosurf easyScan 2 Signal Module: A
Output signal All output signals of Signal Module: S

Additional analog user out-  2x 16bit D/A converters, £10V
puts

Synchronisation output 1x TTL: start, end, point sync pulses, varia-
ble width

Additional signal modulation X-Axis, Y-Axis, Z-Axis, Tip Voltage, Excita-

inputs tion

Free connectors 2Xx Aux, connection made on user request

Modulation range +10V, Excitation: 5V



THE EASYSCAN 2 STM

Additional analog user inputs 2x 16bit A/D converters, £10V
Additional modes Almost unlimited

User inputs can optionally be measured in all Imaging and Spectroscopy
modes.

User outputs can be modulated in Spectroscopy measurements.

STM Measurement

STM Scan Head: 500nm lum 500nmLC  1umLC
Maximum Scan rangel) 500nm 1.0pm 500nm l.Opm
Maximum Z-rangel) 200nm 200nm 200nm 200nm
Drive resolution Z2) 3pm 3pm 3pm 3pm
Drive resolution XY2) 7.6pm 15pm 7.6pm 15pm

Current set point 0.1-100nA in 25pA steps 0.02-20nA in 5pA steps

1) These are typical values, the exact values are given on the calibration
certificate that is delivered with the instrument.

2) Calculated by dividing the maximum range by 16bits; atomic resolution
on HOPG can be obtained with all STMs

Imaging modes Constant Current (Topography), Constant
Height (Current)

Spectroscopy modes Current-Voltage, Current-Distance

Tip voltage 10V in 5mV steps

Sample approach Stick-slip motor

Sample size max. 10mm diameter

Components of the system

This section describes the parts that may be delivered with an easyScan 2
STM system. The contents of delivery can vary from system to system,
depending on which parts were ordered. To find out which parts are
included in your system, refer to the delivery note shipped with your sys-
tem. Some of modules listed in the delivery note are built into the Control-



COMPONENTS OF THE SYSTEM

ler. Their presence is indicated by the status lights on the top surface of the
Controller when it is turned on (see section Connectors, Indicators and Con-
trols (p.13)).

Components: The easyScan 2 STM system

1.

© o N o g~ DN

(B
o

easyScan 2 Controller with built in optional Signal Module: A or S
electronics, and other modules used for AFM operation

USB cable

Mains cable

easyScan 2 STM Scan head(s)

Magnifying cover with 10x magnifier

STM Calibration sheet

This easyScan 2 STM Operating Instructions manual
easyScan 2 Software Reference manual

easyScan 2 Installation CD: Contains software, calibration files, and
PDF files of all manuals

. STM Tool set (option). The contents of the STM Tool set are

described in the next section.

11



THE EASYSCAN 2 STM

11. Vibration isolation platform (option)

12. Break-out cable (with Signal Module: S)

13. Connector box (with Signal Module: A)

14. Signal Module cables (2x) (with Signal Module: A)

15. Scripting Interface Certificate of purchase with Activation key printed
on it (with Scripting Interface)

16. Instrument Case

The package may also contain easyScan 2 AFM head(s) and modules for
AFMoperation; these are described in the AFM Operating Instructions.

Additionally, a solvent (e.g. ethanol, acetone) is needed to clean the tools.
This is not included with the contents of delivery.

Contents of the Tool set

The contents of the Tool set depend on the available modules. It may con-
tain:

o
-

[E 2

Contents of the STM Tool set

1. Wire cutters

Flat Nose Pliers

Pointed tweezers: 00D SA
Rounded tweezers: 2A SA-SL

> N



CONNECTORS, INDICATORS AND CONTROLS

Sample holder
Pt/Ir wire: 0.25mm/30cm for making tips (option)

7. STM Basic Sample Kit (option) with HOPG (graphite), gold thin film
and four empty sample supports

8. USB dongle for the Nanosurf Report software (option)

Connectors, Indicators and Controls

Use this section to find the location of the parts of the easyScan 2 STM that
are referred to in this manual.

The Scan head

Tip holder  Tip clamp

Sample holder

( guide bars
/Y/// Sample holder
%/‘ fixing magnet

Approach
piezo motor

Parts of the scan head

The Controller

Status lights
All status lights on top of the Controller will light up for one second when
the power is turned on.

The Probe Status light
Indicates the status of the Z-Feedback loop. It can indicate the following
statuses:

13
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Module lights
Scan Head lights
Probe Status light

/
Video Out \
connector  video In
(optional) - connector
(optional)

Signal Out
connector Signal In Scan head
(optional) connector  cable connector

(optional)

Controller

Serial number

S/N: 23-05-00;

USB outputs
(to dongle)

USB active
light

Mains power  USB input USB power
connector (from PC) light

The easyScan 2 Controller

red Te scanner is in its upper limit position. This occurs
when the tip-sample interaction is stronger than the
set point for some time. There is danger of damaging
the tip due to too high an interaction.

orange/yellow The scanner is in its lower limit position. This occurs
when the tip-sample interaction is weaker than the set
point for some time. The tip is probably not in contact
with the sample surface.

green The scanner is not in a limit position, and the feed-
back loop can measure the sample surface.
blinking green The feedback loop has been turned off in the software.

The Scan Head lights
Indicate the scan head type that is connected to the instrument. The Scan
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head lights blink when no scan head can be detected, or when the Control-
ler has not been initialised yet.

The Module lights

Indicate the modules that are built in into the Controller. The module
lights blink when the Controller has not been initialised yet. During initial-
isation, the Module lights are turned on one after the other.

15



INSTALLING THE EASYSCAN 2 STM

Installing the easyScan 2 STM

The following sections describe the installation of the easyScan 2 STM.

Important!

To enable measurements of atomic resolution to be made the following
precautions must be taken to keep equipment dust and grease free:

» Never let your fingers touch either the wire for tips (figure Contents of the
STM Tool set (p.12), 6), the sample (Contents of the STM Tool set, 7) nor
the parts of the STM scan head indicated in figure Parts of the scan head.

* Only touch the sample holder (Contents of the STM Tool set, 5) at the
black plastic end.

Installing the Hardware

Important!

- Ascertain that the mains connection is protected against excess voltage
surges.

- Place the instrument on a stable support in a location that has a low level
of building vibrations, acoustic noise, electrical fields and air currents.

If the vibration isolation of your table is insufficient for your measurement
purposes, an optional active vibration isolation table is available.

Nanosurf easyScan 2 Controller

easyScan 2 STM system



INSTALLING THE HARDWARE

Installing the Basic STM Package

- Put the STM scan head (Components (p.11), 4) onto the vibration isola-
tion platform (Components, 11).

Fix the scan head cable under the strain relief clip on the platform.

Connect the STM scan head to the Controller (Components, 1).

Connect the USB cable (Components, 2) to a free USB port on your com-
puter, but do not connect it to the easyScan 2 Controller yet. If you have
inadvertently done this anyway, continue with section Installing the Soft-
ware (p.18).

Installing the Signal Module: S

- Connect the Signal Module: S (Components, 12) to the Signal Out con-
nector on the Controller (The easyScan 2 Controller (p.14)).
In case of an upgrade, the Controller must be sent in to your local Nanosurf

distributor for mounting the Signal Module: S electronics in the Control-
ler.

Installing the Signal Module: A

- Connect one Signal Module cable (Components, 14) to the Signal Out
connector on the Controller and to the Output connector on the Con-
nector box.

- Connect the other Signal Module cable to the Signal In connector on the
Controller and to the Input connector on the Signal Module: A.

In case of an upgrade, the Controller must be sent in to your local Nanosurf
distributor for mounting/replacing the Signal Module: A electronics in the
Controller.

Turning on the Controller

- Connect the easyScan 2 Controller (Components, 1) to the mains using
the mains cable (Components, 3) and turn it on.

17



INSTALLING THE EASYSCAN 2 STM

First all status light on top of the Controller shortly light up. Then the Scan
Head lights, and the lights of the detected modules will start blinking, and
all other status lights turn off. The status lights remain blinking until the
Controller is initialised by starting the easyScan 2 software.

Storing the Instrument

If you have to send in the instrument, transport it or if you are not using it
for some time, please pack it in the shipping package or the instrument case,
so that the instrument is protected from dust.

- Turn off the instrument as described in section Turning off the instrument
(p.41), and remove all cables.

- Remove the sample and sample holder. The tip can be left in the scanner.

- Store the sample holder in its container, and check that the silica is still
blue (chapter Maintenance (p.56)).

- Pack all components as shown in figure Packing.

Important!

Always put the instrument in the original Nanosurf shipping box or Instru-
ment Case.

Installing the Software
- Check that the computer on which you want to install the software fulfils
the requirements listed in section Computer requirements (p.9).
- Disconnect the USB cable from the Controller.
- Turn on your computer and start Windows.
Important!

Make sure you have administrator privileges before software installation.
Do not run any other program while installing the scan software.

- Insert the easyScan 2 Installation CD into your CD drive.



INSTALLING THE SOFTWARE

Packing: The easyScan 2 STM system packed in the Instrument Case

The setup program should start automatically. If this does not happen, pro-
ceed as follows:

- Open the easyScan 2 Installation CD.
- Start the program ‘StartCDMenu.exe’.

- Click ‘Full Installation of Nanosurf easyScan 2'.

The installation program will now start installing all components of the
Nanosurf easyScan 2 Control Software: The hardware drivers, the easyScan
2 software, DirectX9.

- Follow the instructions given by the setup program.

Step 1 - Installation of hardware drivers

The Nanosurf hardware needs instrument drivers for the USB hub, the
USB interface and the AFM Video Module. These are installed first.

19
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INSTALLING THE EASYSCAN 2 STM

- Connect the USB cable to the easyScan 2 Controller.

The red USB power light on the Controller should now light up, and the
PC should now automatically detect that new devices have been connected
to it, and start installing the drivers. On some computers, the detection and
installation process may take some time (20 seconds or more), please be
patient. Once all the drivers listed below have been installed, click OK in
the Step 1 Dialog.

If you have already installed the easyScan 2 software or the Mobile S soft-
ware on this computer, it is possible that nothing will happen, because the
drivers are installed already. In this case the drivers listed below should be
displayed in the Windows device manager. If this is the case, you can also
click OK in the Step 1 Dialog.

Standard-USB-hub

The operating system should first find the ‘Standard-USB-hub’, and install
its driver. The installation order of the other drivers may vary.

High Speed Serial Converter

When the operating system finds the ‘USB <-> serial interface’, it asks what
to do:

- Choose ‘Automatic installation’.
- Click the default choice in all dialogs.
The USB High Speed Serial Converter is now installed.

USB Serial Port

When the operating system finds the ‘USB Serial Port’, it asks what to do:
- Select ‘Automatic installation’.

- Click the default choice in all dialogs.

The USB Serial Port is now installed.



INSTALLING THE SOFTWARE

USB Video Adapter

The USB Video Adapter driver is only installed if the Controller contains
a Video Module. When the operating system finds the ‘USB Device’, it asks
what to do to install the ‘USB Video Adapter’:

- Select ‘Automatic installation’.

During installation of the video adapter under Windows XP, Windows
may notify you that the driver is not digitally signed. If this happens:

- Click ‘Continue installation’.

- Click the default choice in all other dialogs.

Repeat Step 1 for all USB ports of the PC, in order to ensure that the instru-
ment works when connecting the Controller to a different PC USB port.

Step 2 - Installation of the easyScan 2 software

- Click the default choice in all dialogs.

The setup program will ask for the directory in which the easyScan 2 soft-
ware is to be installed.

- Install the software in the proposed directory, unless the ‘Program Files’
directory has a different name in your language of the Windows operat-
ing system.

Important!

The easyScan 2 Installation CD contains calibration information (.hed
files) specific to your instrument, therefore you should keep (a backup copy
of) the CD delivered with the instrument.

Step 3 - Installation of DirectX 9
The easyScan 2 software needs DirectX 9 or newer for correct operation.
Click the default choice in all dialogs.

- After installing DirectX9, the computer may have to re-boot.

21
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INSTALLING THE EASYSCAN 2 STM

Installing the software on different computers

You can install the easyScan 2 software on a different computer than the
one that controls the measurement, for example for running the micro-
scope simulation, or for off-line data analysis. Please note:

 |n order to use the Controller, the hardware drivers and DirectX9 must
be installed on the computer it is connected to.

e The Controller and its drivers must be installed when installing the
Nanosurf Scripting Interface.



INITIALISING THE CONTROLLER

Preparing for Measurement

This chapter describes actions that you perform on a day-to-day basis as a
preparation for your measurements, when the instrument has already been
set up according to the instructions in chapter Installing the easyScan 2 STM
(p.16). These steps are preparing and installing the STM tip, selecting a
sample stage, and preparing the sample.

Initialising the Controller

- Check that the easyScan 2 Controller is connected to the mains power
and to the USB port of the control computer.

- Turn on the power.

First all status light on top of the Controller shortly light up. Then the Scan
Head lights and the lights of the detected modules will start blinking, and
all other status lights turn off.

- Start the easyScan 2 software on the control computer.

The main program window appears, and all status lights are turned off.
Now a Message ‘Controller Startup in progress’ is displayed in the software,
and the module status lights start lighting up one after the other. When
initialisation is completed, a Message ‘Starting System’ is shortly displayed
in the software and the Probe Status light, Scan Head status light of the
detected scan head and modules will light up. If no scan head is detected,
both scan head status lights blink.

Preparing and installing the STM tip

The STM tip can be prepared and installed by yourself. This is the most
difficult part of your preparations. It usually needs patience and some prac-
tise to get the first good tip. Only an accurately cut tip enables optimal
measurements. Therefore, cutting and installing should be carried out with
great care. On delivery, the tip with which the STM was calibrated in the
factory is installed in the head. This tip should give atomic resolution, so
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PREPARING FOR MEASUREMENT

you may wish to try to use this tip before preparing your own. Before cut-
ting the tip:

- Clean the cutting part of the wire cutters (figure Contents of the STM Tool
set (p.12), 1), the Flat nose pliers (Contents of the STM Tool set, 2) and the
pointed tweezers (Contents of the STM Tool set, 3) with ethanol.

- Only touch the Pt/Ir wire (Contents of the STM Tool set, 6) with these
tools.

- Remove the old tip from the instrument using the pointed tweezers.

- If the tip wire is still long enough, you may try to cut the same wire again,
otherwise take the Pt/Ir wire. To prepare the tip:

- Hold the end of the wire firmly with the plier.

- Holding the wire with the pliers, move the cutters at a length of approx-
imately 4mm, as obliquely as possible (figure Cutting the STM tip).

Pt/Ir wire
\ pulling
direction

Flat nose
pliers

wire cutter
Cutting the STM tip
- Close the cutters until you can feel the wire, but do not cut the wire.

- Pull in the direction shown in the figure. The tip needs to be torn off
rather than cleanly cut through, in order to get the required sharp tip.



PREPARING AND INSTALLING THE STM TIP

STM tip: Scanning Electron Microscope images of an STM tip
- Use the pointed tweezers to hold the tip wire with just behind the tip.

- Release the flat pliers.

Important!
Do not touch the end of the tip with anything.
« Ensure that the tip wire is straight.

* Do not twist the tip clamp in the open part of the scan head nor lift it too
high.

The procedure for mounting the tip under the tip clamp depends on the

type of clamp on your scan head:

Single clamp
Proceed as is illustrated in figure Mounting the tip under the single clamp:

Mounting the tip under the single clamp

1. Putthe tip wire on the tip holder parallel to the groove in the tip holder,
so that it crosses below the tip clamp (figure a).

2. Move the tip wire sideways until it is in the groove in the tip holder
(Figure b).

25



PREPARING FOR MEASUREMENT

The freshly cut tip should be securely held under the clamp and extend
about 2-3mm beyond the tip holder. The tip is now installed.

Double clamp

Always use the following procedure for mounting the tip under the double
clamp (figure Mounting the tip under the double clamp). Using a different
procedure may cause a gradual deterioration of the measurement quality
due to loosening of the clamp.

~L

a) b)

Mounting the tip under the double clamp

1. Hold the tip wire at a slight angle, and move it along the groove against
the first clamp, so that the end of the wire is under the clamp (figure a).
Lower the wire so that it lifts the first clamp (figure b).

Push the wire in, until it touches the second clamp.

Lift the wire.

Push the end of the wire below the second clamp.

Lower the wire so that it lifts the second clamp (figure c).

Push the wire under the second clamp.

The freshly cut tip should be securely held under the clamp and extend
about 2-3mm beyond the tip holder. The tip is now installed.

N o gk N

Installing the sample

Preparing the sample

The STM can only examine electrically conductive materials. Nevertheless
the choice of material is rather small because the surface of the sample must
not oxidise, be totally clean and mirror-like to obtain useful results. Because
of this some of the samples need special preparation.



INSTALLING THE SAMPLE

Important!
Never touch the sample's surface once it is prepared.

Gold thin film

Cleaning the sample is neither possible nor necessary. Never touch the sam-
ple with your fingers or put it upside down anywhere, this will only make
it unusable faster.

Graphite

The surface of the graphite sample can be cleaned when it is very dirty or
uneven. Due to the layered structure of graphite this can easily be done
using a piece of adhesive tape (figure Cleaving graphite):

% ;
- “

o

Cleaving graphite

- Put the sample on the table using the pair of tweezers.

- Stick a piece of adhesive tape gently to the graphite and then pull it off
again: The topmost layer of the sample should stick to the tape.

- Remove any loose flakes with the pair of tweezers.
The graphite sample is now ready for use and may not be touched.

Installing the sample

Important!

Always store the sample holder in its package, in order to prevent corrosion
(chapter Maintenance (p.56)).

- Unpack the sample holder (figure Contents of the STM Tool set (p.12), 5)

27



PREPARING FOR MEASUREMENT

touching only its black plastic handle.

- Put the prepared sample onto the magnetic end of the sample holder
using a pair of tweezers (Figure Putting the sample on the holder):

il

Putting the sample on the holder

- Place the sample holder carefully in the scan head so that it doesn’t touch
the tip, and the sample is not pulled from the sample holder by the mag-
net that holds the sample holder in place (figure Placing the sample holder
in the scan head).

Placing the sample holder in the scan head

- Put the sample holder down on to the sample holder guide bars first and
release it gently on to the approach motor’s support.

28



RUNNING THE MICROSCOPE SIMULATION

First Measurements

In this chapter, step by step instructions are given as to how to operate the
microscope and make a simple measurement. More detailed explanations
of the software and the system are given in the Software Reference manual.

Running the microscope simulation

You can start the easyScan 2 software without having the microscope con-
nected to your computer in order to explore the easyScan 2 system (meas-
urements and software) without danger of damaging the instrument or the
cantilever. In the simulation mode, most functions of the real microscope
are emulated. The sample is replaced by a mathematical description of a
surface.

When you start the easyScan 2 software when no microscope is connected
to your PC, the following dialog appears:

Manosurf Easyscan 2

't USE Port errar:
.

Part nok found
Check if USE cable is connected

- Click ‘OK’.
The status bar will now display the text ‘Simulation’.

You can also switch to the simulation mode with the microscope con-
nected:

- Select the menu entry ‘Options>Simulate Microscope’.

A check will now be displayed in front of the menu entry.

To exit the Microscope simulation mode:

- Select the menu entry ‘Options>Simulate Microscope’ again.

The check in front of the menu entry is now removed, and the status bar
will now display the text ‘Online’.



FIRST MEASUREMENTS

Preparing the instrument

Prepare the instrument as follows (Refer to chapter Preparing for Measure-
ment (p.23) for more detailed instructions):

- Prepare and install a Pt/Ir tip.

- Install the HOPG sample.
To make sure that the configuration is correct, do the following:

- Open the User interface dialog via the menu ‘Options/Config User Inter-
face...”.

- Select the ‘Easy level’ user interface mode.

- Open the menu item ‘File>Parameters>Load...’, and load the file
‘Default_EZ2-STM.par’ from the directory with default easyScan 2 con-
figurations. Usually this is ‘C:\Program Files\Nanosurf\Nanosurf easy-
Scan 2\Config’.

Entering values in the control panels
To change a parameter in any panel, use on of the following methods:

« Activate the parameter by clicking it with the mouse pointer, or by select-
ing it with the Tab key.

» The value of an activated parameter can be increased and decreased using
the up and down arrow keys on the keyboard. The new value is automat-
ically used after one second.

» The value of a numerical parameter can also be increased and decreased
by clicking the arrow buttons 4 with the mouse pointer. The new value
is automatically used after one second.

» The value of an active numerical parameter can also be entered using the
keyboard.
The entered value is used on pressing the ‘Enter’ or ‘Return’ key, or by
activating another input.
The entered value is discarded on pressing the ‘Esc’ key.



APPROACHING THE SAMPLE

Type the corresponding character to change the unit prefix:

prefix keyboard key prefix keyboard key
femto f no prefix space bar
pico p kilo k

nano n mega shift - M
micro u giga shift - G
milli m tera shift- T

Unit prefixes with corresponding character

For example, if the basic unit is Volts, type ‘m’ to change to millivolts,
type the space bar for volts, type ‘u’ for microvolts.

* The selection of a drop-down menu (e.g.: |Phass Contias ~]) can be
changed using the mouse or the up and down arrow keys on the key-
board.

Sometimes the program will change an entered parameter value to a slightly
different value. This happens when the desired value is outside the range
that the easyScan 2 Controller can handle, for example due to the resolu-
tion limits or timing limits. The desired value is automatically changed to
the nearest possible value.

Approaching the sample

To start measuring, the sample must be very close to the tip to enable a
tunneling current to flow. Approaching the sample without touching the
tip is a delicate operation carried out in three steps. Manual coarse
approach, manual approach using the approach stage, and the automatic
final approach. The colour of the probe status light on the Controller shows
the status of the approach:

orange Normal state during approach, the Z-scanner is fully
extended toward the sample.
red The approach has gone too far, the tip was driven into

the sample, and the Z-scanner is fully retracted away
from the sample. In this case, the tip is probably dam-
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aged, so you will have to start over again with prepar-
ing a new tip.

green The approach is finished, the Z-scanner is within the
measuring range, tunneling current should be flow-
ing.

1. Manual Coarse approach

- Push the sample holder carefully to within Zmm distance of the tip.

Manual Coarse approach

- If the tip is pointing toward a rough area of the sample, try turning the
sample holder around its axis so that the tip points towards a flat, mirror-
like area of the sample.

- Put the magnifying cover (Components (p.11), 5) over the scan head with-
out touching the sample holder.

- Place the magnifier so, that you can see the mirror image of the tip in the
sample.

The cover reduces air flow around the scan head and reduces thermal drift
in measurements at atomic scale.



APPROACHING THE SAMPLE

2. Manual approach using the piezo motor

The piezo motor is operated using the Approach Panel in the Positioning
window. To open this window:

- Click the Positioning icon @ in the Navigator.

- Watch the distance between tip and sample with help of the magnifier.
Now click | ¥ sdnce in the Approach Panel to move the sample towards
the tip to a distance of a fraction of a millimetre.

You should only just be able to see the gap between the tip and its mirror
image (figure Tip-sample position). The smallest visible gap depends on the
observation angle of the magnifier and the lighting of the sample.

Tip-sample position: Position at the end of the Manual approach with the piezo motor.

If you can not see the motor has moving, clean the sample holder guide bars
and the surfaces of the approach motor following the procedure described
in chapter Maintenance (p.56).

3. Automatic final approach

In the last step, the tip approaches the sample, until the set point is reached.
First check that the set point and the feedback speed are set properly:

- Click | &g/ in the Navigator to open the Z-Controller Panel.
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Z-Controller Panel ®

Z-Controller

Set point | Tnd

®)
E
Loop gain | 1000 E
®)
i

Tip Properties

Tip voltage | 0.05%

- Set ‘Set point’ (tunneling current) to 1.00nA.

- Set Loop gain (the speed of the feedback loop) to 1000 for normal heads,
or to 200 for LC heads.

- Set ‘Tip voltage’ (tip-sample-voltage) to 50mV.

Now that the feedback settings are correct, the automatic final approach
can be started:

- Click in the Approach Panel.

The sample holder is now stepped towards the tip with the help of the piezo
motor. After each step, the Z-scanner is fully retracted from the sample, and
released to move towards the sample. The approach is finished if the cur-
rent determined by Set point is detected before reaching the maximum
extension of the Z-scanner, otherwise the approach motor will continue
with the next step. Due to the motion of the Z-scanner, the Probe Status
light will blink red-green-orange-red-green-etc.

If the approach was finished successfully, the probe status changes from
blinking to green and the message box ‘Approach done’ appears.

- Click the ‘OK’-button.

If the status light change to red instead of green, or if the approach has not
finished after 10 - 20s, try to decrease the tip-sample distance a little more
using manual operation of the piezo motor. If the automatic final approach
never works, refer to chapter Problems and Solutions (p.58) for the next steps
to take.
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Starting a measurement

Now that the tunneling current defined by Set point is flowing between tip
and sample you can start measuring:

- Click | g/ to open the Imaging window.

The STM has already started imaging the sample.

If the preparation of tip and sample and the approach were successful,
images of the measurement will show a more or less straight line in the Line
graph (figure Starting image, left) and a plane in the Color map. Watch the
displays for a while until the Color map-image has been drawn about three
times.

Topography - Scan forward Topography - Scan forward
£

A100nm
100nm

Rawdata

Topography range
Topography range

-100nm

onm xr anm = onm e anm

Starting image: left: a good Line graph; right: a ‘nervous’ Line graph.

A ‘nervous’ line in the Line graph indicates a bad tunneling contact (figure
Starting image, right). Usually this is caused by the tip being too blunt or
instable. This means that you should stop measuring and cut a new tip:

- Click and follow the instructions of the chapter Problems and Solu-
tions (p.58).

If the line in the Line graph is calm and reproduces consistently, you can

continue with the next section.

Achieving atomic resolution

You prepared your measurement so that the Topography in the Line graph
is reproducing stably. Now the scan range has to be decreased in order to
observe the atomic structure.
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Reminder: Measurements on the nanometer scale are very sensitive. Direct
light, fast movements causing air flow and temperature variations near the
scan head can influence and disturb the measurement. It is best to let a
promising measurement run for some time to let it stabilize thermally.

To decrease the Imaging area:
- Click the Color map chart to make it active.
A gray square is now drawn around the Color map chart.

- Click #zom

The mouse pointer becomes a pen when moving over the selected chart and
and the Tool Results Panel opens.

- Move the mouse cursor to a ‘flat’ region (similar color) in the Color map
and click on it.

The software will now draw a square that indicates of the new scan range.
The size of the new scan range is displayed in the Tool Results Panel. If no
flat region is available, refer to chapter Improving measurement quality
(p.42) for further instructions.

Topography - Scan forward

S00nm

Raw data 7.54nm

Tool status

Size:  50.78nm

Topography range

Onm

Zoom

- Change the size of the new scan range to about 30-50nm by clicking and
dragging a corner of the square with the mouse cursor.

- Double click the chart when the scan new area is set as you want it. You
can abort the zoom function by clicking with the right mouse button.



THE GRAPHITE SURFACE

The imaging settings are now set in such a manner that the new measure-
ment will correspond to the area that was indicated by the square.

The image size should be decreased even further, considering that one
nanometer is the diameter of between four and eight atoms. Atomic
arrangements can normally be made out at an Image size of about 4nm:

- Set the Image size in the Imaging panel to 4nm.

- Some parts of the scan head react to the slightest temperature changes. As
these thermal ‘movements’ influence the measurements on the nanome-
ter scale, the sample has to be scanned as fast as possible.

- Set the Time/Line in the Imaging Panel to 0.06s for atomic resolution.

- You may also try to decrease noise by decreasing the Loop gain of Z-
Controller.

- Try varying these parameters to get a nice image of the graphite surface.

Topography - Scan forward

233pm

Line fit 73.2pm

tean fit

-294pm

0nm }{:‘ 4.37nm

Topography range

Good images of a successful measurement

The graphite surface

In a good color map chart of graphite you will see a pattern consisting of
white, grey and black spots. It looks like a three dimensional image of balls
lying next to each other, but be careful: these are not the single atoms!
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To interpret the image correctly you must first be aware that bright spots
show high points and dark spots low ones.

In the lattice model of graphite one can see that there are two different
positions of the carbon atoms in the graphite crystal lattice: One with a
neighbouring atom in the plane below (grey) and one without a neighbour
in the lattice below (white). As a consequence, the electrical conductivity of
the graphite surface varies locally slightly so that the atoms without neigh-
bours appear higher than the others.

L 0.25nm\J 0.14nm

Graphite surface: left: measurement; right: lattice model

This also causes the lattice constant between the bright ‘hills’ to have the
higher than normal value of 0.25nm.

Storing the measurement

When you are satisfied with your image and would like to keep it, you can
take a snapshot of it by clicking the =reo button. The behaviour of this
button depends on whether a measurement is in progress or not.

When a measurement is in progress, and =rhete is activated, a copy of the
measurement is made to a measurement document after the measurement
is finished.

When the measurement is not in progress, a copy is made immediately.

If you would like to take the snapshot of the measurement as it appears
during the measurement without waiting to finish:



FINISHING

- Click to stop scanning.
- Generate a snapshot by clicking e=rhats,

If you want to save the measurement document to your hard disk drive, for
example for loading it to Nanosurf Report:

- Activate the measurement document by clicking in its window, or by
selecting it in the ‘Windows’ menu.

- Select the menu ‘File>Save as...”. Select the folder and file name where
you would like to store the measurement.

The stored measurements can now be loaded with the easyScan 2 software
and the Nanosurf Report software for later viewing, analysis and printing
(see also Software Reference manual).

Finishing
Once you are done measuring:

- Click to stop measuring.
- Retract the sample holder first by using | t#ihdraw  then | 4 Retract

Remove the magnifying cover from the scan head.

Remove the sample holder with one hand.

Remove the sample from the sample holder and store it in its case with
the other hand.

Store the sample holder in its container.

Measuring Gold

It is more difficult to obtain good images of a gold. Atomic structures are
difficult to observe because the electrons on the surface are much more
homogeneously distributed than in graphite. But with some training the
mono-atomic gold steps can be observed.
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Topography - Scan forward

2.07nm

LLine fit 1.35nm

tean fit
Topography range

-2.07nm

0nm }{:‘ 215nm

Topography range

Due to the fact that the gold sample cannot be cleaned by simple means it
is possible that with time contaminants may prevent you from obtaining
good results.

Tip:

Before you do any experiments with the gold sample it is necessary to prac-
tise on the graphite sample. You should also test the quality of your tip
using the graphite sample.

Proceed as you did with the graphite sample, but there are two exceptions
to note:

- Set the Tip voltage in the Z-Controller panel to 0.5V.

- Set the Time/Line in the Imaging Panel to 0.3s.

If you do not get stably reproduced scan lines you should look for another
clean measuring spot.

- First try with | wihaaw  followed by | #eeeach . If that does not change
much retract the sample holder and rotate it a little by hand. Repeat the
approach.

- If the image reproduces stably, select a Image size between 200 and
300nm.

Evaluate your measurements in the same way as you did with the graphite
images, zoom, measure, save etc.



CREATING A REPORT

Creating a report

The optional Nanosurf Report software can be used for evaluating the
measurement, and creating visually appealing reports. Here, we will just
start the software and create a basic report.

- Click 2] in the Navigator.

The Report software will now start, open the currently selected measure-
ment in the report software, and evaluate it with the default template.

For an in depth introduction to the Nanosurf Report software, refer to the
Introduction section of the Nanosurf Report online help.

Turning off the instrument

- Follow the instructions from section Finishing (p.39).
- Verify that you have saved all measurements that you would like to keep.

- Exit the easyScan 2 software after having stored all desired measurement
documents. If you exit the program whilst having some unsaved measure-
ments, you will be asked to save them now.

- Turn off the power switch.

If you perform measurements regularly leave the instrument with the Mag-
nifying cover over the scan head to protect it against dust.

If you do not operate the instrument for several weeks, store the instrument
as is described in section Storing the Instrument (p.18).



IMPROVING MEASUREMENT QUALITY
Improving measurement quality

Judging and improving tip quality

From the quality of the measured images the quality of the tip and conse-
guently that of the tunneling contact can be observed. A good tunneling
contact is necessary for high quality images of atomic resolution.

If during a good measurement the image quality diminished dramatically,
the tip has most probably picked up some particles or you are near a step in
the surface.

Topography - Scan forward

Y
LLire fit 91 Gpm

i
0nm w 1.93nm

- Continue measuring for a while (4-5 images); the tip may eventually lose
the picked up material again.

If this does not help, try to induce changes at the tip’s end using one of the
following procedures:

« While measuring increase the gap voltage in the ‘Feedback Panel’ to 2V
then reduce it to the old value again.

* Increase the tunneling current to 20nA for a short time then reduce it to
its old value again.

« Retract the sample, then perform a new approach.



JUDGING AND IMPROVING TIP QUALITY

If no improvement can be seen after going through these procedures, you
have to prepare a new tip:

- Follow the instructions from section Finishing (p.39).
- Follow the instructions in section Preparing and installing the STM tip
(p-23).

Examples of images made with unusable tips
Prepare a new tip when your image looks like one of the examples below.

Topography - Scan forward Topography - Scan forward

16.6nm

Line fit 1.18nm

tean fit
Topography range

-16.6nm

0nm }{:‘ 499nm

Topography range

The color map image consists of uncorrelated lines.

Topography - Scan forward Topography - Scan forward
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The image is ‘smeared out’ on one border (here on the left border).
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Topography - Scan forward Topography - Scan forward

932pm

Lire fit 903pm

tean fit

Topography range

-1.13nm

0nm }{:‘ 3.91nm

Topography range

Each image looks different.

Topography - Scan forward Topography - Scan forward

&.28nm

Line fit 25nm

tean fit
Topography range

-8.3nm

0nm }{:‘ 498nm

Topography range

0nm W

The scan lines in Line graph are unstable and the image in the Color map is blurred.

Decreasing thermal drift

Temperature variations cause so-called ‘thermal drift’. This will cause
images to be distorted. This effect can be observed when e.g. the upward
scan is very different to the downward scan showing two differently dis-
torted lattices.



REMOVING INTERFERING SIGNALS

Topography - Scan forward

Topography - Scan forward

Line fit 29Gpm
Line fit 29Gpm

Consecutive upward and downward scan showing thermal drift.

Thermal drift is very clearly perceptible on an atomic scale. Variations of
0.1°C already cause variations in the length of e.g. the sample holder (steel)
of several nanometers.

To decrease thermal drift, keep the measurement running for some time to
let the system stabilize (up to about one hour).

Removing interfering signals

Interfering signals can be recognised because they have a fixed frequency,
usually a multiple of the local mains frequency (50 or 60Hz) throughout
the image. Thus, they are manifested by straight lines, that run throughout
the image.

Possible interference sources are:

» Mechanical vibrations from machines or heavy transformers in the envi-
ronment (e.g. pumps).

« Electrical interference (in the electronics, or in electrical forces in the tip-
sample interaction).

Mechanical vibrations
To find out if the interference is due to mechanical vibrations:

- Measure the frequency of the vibrations.
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These vibrations have a frequency that is (a multiple of) the rotation fre-
guency of the source. This frequency is usually not a multiple of the local
mains frequency, and may change slightly over time. Try the following to
find out if the interfering signal is due to mechanical vibrations:

- If possible, turn off all rotating machines (i.e. pumps) in the room.

- Change the vibration isolation by putting the Scan head directly on the
table, instead of on the Sample stage.

To reduce the influence of these vibrations, either improve the isolation of
these machines, or improve the isolation of the instrument by using a vibra-
tion isolation table (e.g. the optional TS-150 active vibration isolation table
option).

Electrical interference

Electrical interference may be caused by interference in the electronics, or
by electrostatic forces acting between the tip and the sample. Try the fol-
lowing in order to reduce the influence of electrical interference:

- Connect the instrument to the mains power supply using sockets with
line filters and surge protection.

- Remove interfering electronagnetic field sources, such cathode ray tube
displays, loudspeakers, ...

Adjusting the measurement plane

Ideally, the plane of the measurement and the sample surface lie in the XY-
plane of the scanner. But mostly the sample plane is tilted with respect to
that ideal plane, as shown is figure Maladjusted slope. In this case, the sam-
ple cross section in the X* measurement direction, as shown in the Line
graph window, has a certain slope. This slope depends on the direction of
the X* direction and therefore on the rotation of the measurement, as
shown in figure Slope.

The measurement plane should be parallel to the sample plane because:

« When the Average, Plane fit or higher order filters cannot be used because
they would distort the image, it is easier to see small details on the sample



ADJUSTING THE MEASUREMENT PLANE

d
T Imaging window E]@
Stop | Finish  EUp MDown S Zoom OxMaove % Ful Spec | emPhota
I e = Topography - Scan forward

E00nm

Image size | 0.5um

Time / Line 0.2¢

Raw data 27nm

Paints / Line 128

A 3D 4D 31

Raotation 0+

Imaging Optians

%Slops 0°
¥Slops 0°

Owerscan 0%

BE7nm

Topography range

Mean fit
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Topagraphy range
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Maladjusted slope: Measurement with improperly set X*-slope.

. 'Rotat|on
angle

-._Measurement plane

'Y-Slope'
angle

Image area

_______________ . ‘X Slope' angle

Scanner XY-plane

Slope: Sample’s and measurement orientation before slope adjustment
surface when the planes are parallel.

e The Z-Controller functions more accurately, because it does not have to
compensate for the sample slope.
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The measurement plane should therefore be adjusted electronically using
the parameters ‘X-Slope’ and ‘Y-Slope’. To find the correct values, use the
following procedure:

- The slope correction is only available with the Standard level and the
Advanced level user interface mode. Open the User interface dialog via
the menu ‘Options/Config user interface, and select one of these modes.

- Measure the slope in the Line graph using the angle tool (see Software
Reference). Use a single click to measure the angle relative to the X*-axis.

- Alter the value of ‘X-Slope’ in the Imaging options of the Imaging Panel
until the X-axis of the scan line lies parallel to the X-axis of the sample.

T Imaging window E]@

Stop  Finish EUp [ Down WFul | Spec | emPhoto

Mz e = Topography - Scan forward

Imaging Area

S00nm

Image size 0.5um

Time / Line 0.2 ¢

Rawedata 1 36nm

Paints / Line [128

oojonjionjioni s

Botation 0

Imaging Options

%Slope | 1830m°

Topagraphy range

-Slope |-4676m"

aganjofl &)

Onm

Overscan 0%

onm o 500nm

Topography - Scan forward

261pm

Mean it
Topography range

-1 24nm

onm xr 500nm

Charts after adjusting the slopes

- Set Rotation to 90° to scan along the Y-direction of the scanner.

- If the scan line is not horizontal, alter the value for “Y-slope’ until the Y-
axis of the scan lies parallel to the Y-axis of the sample.



ADJUSTING THE MEASUREMENT PLANE

- Reset ‘Rotation’ to 0°. The Line graph shows the X-slope again.
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Measurement modes

The surface can be scanned in two different ways: in the Constant current
and Constant height mode.

In the Constant current mode, the tunneling current is kept constant by
the Z-Controller. The output of the Z-Controller thus corresponds to the
height of a surface of constant tip current. This output is then recorded as
a function of X and Y position, and is displayed as the Topography signal.

In the Constant height mode on the other hand, the tip does not follow a
surface of constant tip current. Instead the variation of the tunneling cur-
rent is directly recorded as a function of the X and Y position in plane
parallel to the sample surface.

The easyScan 2 STM is normally configured to measure in the Constant
current mode. To switch to the Constant height mode, you could theoret-
ically just turn off the Z-Controller. However, several probblems arise:

 The tip would crash into the slightest unevenness of the surface.

« The scan plane of the scanner must be very well adjusted to the plane of
the sample.

e The thermal drift in the Z-Direction will cause the tip to rapidly move
away from the sample, or even worse, to be pressed into it.

» These problems can for a large part be avoided by setting the Loop-gain
to a very low value. Thus, the feedback loop can follow the slow move-
ment of the sample caused by thermal drift and the sample plane, but not
the fast height changes due to the presence of the atoms.

To measure in Constant height mode:

- Find a flat area of the sample by imaging it in Constant current mode,
and zoom in on this area.

- Open the User Interface configuration dialog using the menu
‘Options>Config User Interface...”.

- Set the User Interface Mode to ‘Standard level’ or ‘Advanced level’.



ADJUSTING THE MEASUREMENT PLANE

- Click to open the Z-Controller Panel.
- Set I-Gain to 4.

- Set P-Gain to 0.

To visualize the current:

- Click on a Color map chart in the Imaging Window.

- Set the Input channel to ‘Tip Current’ in the chart bar.

The bar next to Color map should now display the text ‘Tip Current’ and
have the units ‘pA’ or ‘nA’ instead of ‘nm’.
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The Signal Modules

The Signal Modules consist of both electronics modules that are built into
the Controller and a break-out Connector that is externally attached to the
Controller. The Signal Modules can be used for monitoring the signals
from (Signal Module: S) and adding functionality to (Signal Module: A)
the easyScan 2 system. The Signal Module: A includes all the monitoring
functions of the Signal Module: S.

For information on installing the Signal Modules, refer to secion Installing
the Hardware (p.16).

Signal Module: S

The Signal Module: S can be used for monitoring signals from the STM
with external instruments, such as Volt-meters, Oscilloscopes or Spectrum
Analysers. The signals are available on nine BNC connectors that are
labelled with their signal names. The signal names and their function are
listed in the table Monitor Signals:

Signal name  Function

X-Axis X-Position command of the Scanner. Is affected by Image
X-Pos and the Imaging Area Rotation.

Y-Axis Y-Position command of the Scanner. Is affected by Image
X-Pos and the Imaging Area Rotation.

Z-Axis Z-Position command of the Scanner. Is affected by the Z-

Controller output, Ref. Z-Plane, X- and Y-Slope.
Tip Voltage  The voltage applied to the tip.

Approach The voltage ramp that drives the approach motor.
Excitation no signal (AFM only)

Deflection The tip current (see below)

Amplitude no signal (AFM only)

Phase no signal (AFM only)

Monitor Signals
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The calibration of the monitor signals can be found by looking up the sig-
nal calibration in the Scan Head Calibration Dialog, reached via the menu
‘Options>Config Scan Head...". The magnitude of the physical signal can
be calculated from the Monitor Signal voltage using the formula:

PhysicalSignal[Unit] = Monltorsllog[il/a]ll Voltage, Maximum + Offset

The Tip Current signal depends both on the Tip voltage, and the tunneling
current. The current can be calculated using the formula:

TipCurrent = (T pCurrenthnaig/[o\I/t]age—Tl pVoltage) Maximum + Offset

In addition to the monitor voltages, +15V and -15V voltage sources are
available for driving small home-made electronics. The voltages are availa-
ble on a three-pole mini-DIN connector. The pin-out of this connector is
shown in figure Voltage source connector.

1. +15v[ O D O |2:GND
@)

3:-15V

Voltage source connector: as seen from outside.

Signal Module: A

The Signal Module: A can be used for adding functionality to the easyScan
2 system in addition to the applications fo the Signal Module: S. The sig-
nals are available on twenty-one BNC connectors that are labelled with
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their signal names. The signal names and their function are listed in the
tables Monitor Signals (p.52) and Signal Module: A Signals:

Signal name

Function

Sync

User 1 Output

User 2 Output

X-Axis Input
Y-Axis Input

Z-Axis Input

Tip Voltage

An output that can be used to synchronise external equip-
ment with the Controller. This feature will be described in
more detail in a future manual version (refer to the Nano-
surf Web site).

An analog output that can be used to drive external instru-
ments using the Controller. The User output can be used
for special spectroscopy measurements.

An analog output that can be used to drive external instru-
ments using the Controller. The User output can be used
for special spectroscopy measurements.

The Input voltage is added to the X-Position command of
the scanner.

The Input voltage is added to the Y-Position command of
the scanner.

The Input voltage is added to the Z-Position command of
the scanner. If the Z-Controller is turned on, it will try to
compensate this voltage, as a result of which, the Input
voltage will be added to the topography measurement.
The input voltage is added to the Tip-voltage set in the
software.

Excitation Inputno function (AFM only)

User 1 Input

User 2 Input

An analog input that can be used to record the signal from
external instruments in Imaging and Spectroscopy meas-
urements.
An analog input that can be used to record the signal from
external instruments in Imaging and Spectroscopy meas-
urements.

Signal Module: A Signals



SIGNAL MODULE: A

Signal name  Function

Aux 1 A connector that can be used for accessing signals that are
not otherwise available. Contact your local distributor if
you need to use this connector.

Aux 2 A connector that can be used for accessing signals that are
not otherwise available. Contact your local distributor if
you need to use this connector.

Signal Module: A Signals

The sum of the modulation inputs and the output value (for example of X-
Axis) should not exceed the -10V - +10V range.

In addition, -15V and +15V voltage sources are available for driving small
home-made electronics. The voltages are available on the same type of
three-pole mini-DIN connector that is used in the Signal Module: S. The
pin-out of this connector is shown in figure Voltage source connector (p.53).

Using the User Inputs and Outputs

The user Inputs and Outputs can be configured using the User Input/Out-
put section of the Operating Mode Panel. This Section is only available in
the Advanced Level User Interface.

55



MAINTENANCE

Maintenance

To ensure the fault-free operation of the microscope the following instruc-
tions for maintenance have to be followed.

Scan head

It is very important to prevent the sample holder and the open part of the
scanner from becoming dirty or damp.

Protecting the sample holder against corrosion

The approach motor will not run well if the sample holder is dirty or cor-
roded.

The sample holder is made of magnetic steel and therefore suffers from
corrosion in a humid environment. To reduce corrosion and increase life
expectancy, the sample holder must be stored in its container together with
the moisture absorbing silica container. The container is waterproof but
not airtight. The silica contains a blue indicator which turns pink when
saturated. To regenerate the silica:

- Heat the silica container at 100°C for at least two hours until it turns
completely blue again.

Cleaning parts of the approach motor

If you have touched the metal part of the sample holder, or it has otherwise
become dirty, or the approach motor does not move:

- Take a soft cloth, if necessary moistened with alcohol.

- Clean the holder by moving the cloth along the sample holder in the axial
direction, do not move it around its circumference.

- Let the parts dry before operating the motor again.
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If the approach motor still does not move:

- Take a cotton swab, if necessary lightly moistened with alcohol.

Cleaning the sample holder guide bars

- Clean the sample holder guide bars (figure Cleaning the sample holder
guide bars).

- Clean the surfaces of the piezo motor that touch the sample holder.
- Clean the tip holder (remove the tip when doing this).
- Let the parts dry before operating the motor again.

Scan electronics

Clean the case and the controls with a soft cloth lightly moistened with a
mild detergent solution. Do not use any abrasive pads or solvents like alco-
hol or spirits.
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Problems and Solutions

Common problems

The problems described here can occur during normal operation of the
microscope. If the suggested course of action does not solve the problem,
or the problem is not described here, refer to section Nanosurf support at the
end of this chapter.

No connection to microscope

Manosurf Easyscan 2

& Mo connection to microscope!

Check power supply and cable connection.

Start Simulation [ Try again

This error message appears when the easyScan 2 software is waiting for an
answer from the Controller. Most likely, the easyScan 2 Controller is not
connected to the mains power, or not turned on. In this case the status
lights on the top of the electronics are not on.

Check the connection and the power switch.

USB Port error

Manosurf Easyscan 2

'E USE Port errar:
.

Part nok found
Check if USE cable is connected

The USB cable is not properly connected. In this case the USB power light
on the Controller rear panel (figure Parts of the scan head (p.13)) does not
light up.

Check that the USB cable is properly connected.



COMMON PROBLEMS

Manual approach is too slow / stops sometimes

If the manual approach using the piezo motor (buttons and
[+ react)) s affected:

- Clean the sample holder guide bars and the surfaces of the approach
motor following the procedure described in chapter Maintenance (p.56).

Automatic final approach is too slow / stops sometimes
Even if the manual approach works, the automatic final approach (button

[ apesach_|) May not work.

- Clean the sample holder guide bars and the surfaces following the proce-
dure described in chapter Maintenance (p.56).

If cleaning does not help the step size may be too small:

- Open the User Interface configuration dialog using the menu
‘Options>Config User Interface...”.

- Set the User Interface Mode to ‘Standard level’ or ‘Advanced level’.

- Increase the value of Appr. Speed in the Approach Options section of the
Approach Panel by a few percent until the approach works.

Now the motor moves the sample holder with larger steps during automatic
approach.

- Save the new value of Appr. Speed using the menu ‘File>Parame-
ters>Save’.

Automatic final approach crashes the tip into the sample

In this case the motor moves the sample holdertowards the tip with too
large steps:

- Open the User Interface configuration dialog using the menu
‘Options>Config User Interface...”.

- Set the User Interface Mode to ‘Standard level’ or ‘Advanced level’.

- Decrease the value of ‘Appr. Speed’ in the Approach Options section of
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the Approach Panel by 10%.

- Repeat the approach with a new tip. If the approach fails again, reduce
‘Appr. Speed’ further.

- Save the best ‘Appr. Speed’ value using the menu ‘File>Parameters>Save’.

Image quality suddenly deteriorates
There are several possible causes:
Z-Drift
The tip drifted outside the Z-range of the scanner. In this case, the probe

status light will either light up orange or red. If the light is orange, the tip
has lost contact with the sample:

- Click in the Approach Panel then repeat the steps in chapter
First Measurements (p.29).

If the light is red, the tip has drifted into the sample. You can try to move
the sample surface within the Z-range of the scanner, although the tip may
already have been damaged:

- Click in the Approach Panel.

If the light is still red aftwer withdrawing, prepare a new tip (sectionPrepar-
ing and installing the STM tip (p.23)).

- Click [“ames |

XY-Drift

The scanner may have drifted close to a deformity in the sample's surface.
Try to find a different measurement position:

- Increase the scan range.

- Zoom into a flat area.
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Tip modification

The tip may have picked up some particles or other material from the sam-
ple surface. In this case, follow the instructions given in chapter Improving
measurement quality (p.42).

Nanosurf support

Self help

The fastest way to solve a problem is often to solve it yourself. If the previ-
ously suggested actions did not help, or the problem is not described here,
refer to the Nanosurf support pages:

- Open www.nanosurf.com.
- Click on support.

- Enter te combination of serial number and password that you received on
registering.

- Select the easyScan 2 link.

- If the problem is software related, try to upgrade to the latest version,
and/or read the What'’s new file to see if the problem was solved. For the
solution to other problems, refer to the Frequently Asked Questions
(FAQ).

If your instrument was not registered already, you will first have to register

to get a password.

Assistance

If the standard solutions are not sufficient, contact your local distributor for
help. In order to resolve the problem as fast as possible, please provide as
much information as possible, such as:

« A detailed description of what happened before the problem occurred.
For example: ‘When 1 click the approach button, then quickly click
abort, the Controller will not react to any I do anything any more.’


http://www.nanosurf.com
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* Ifan error message was displayed: The exact text of the message, or at least
its start.

 The serial number of your scan head and/or Controller.

A description of the computer hardware and software on which the con-
trol software is running: computer brand, type (lap-/desktop), operating
system, software version etc.

« Original Nanosurf image data (.nid) files that show the problem, rather
than bitmap screen shots, because these files contain all the settings that
were used to make them.

» Parameter (.par) files with the instrument settings that were used when
the problem occurred.



WHAT IS STM?

STM Theory

What is STM?

Microscopy is one of the most exciting scientific techniques. The insight
into small dimensions has led to a new understanding of the structure of
materials and forms of life.

With the help of the scanning tunneling microscope (STM) it is possible to
look into the fascinating world of the atoms. This completely new micros-
copy technique works without focusing elements and features atomic reso-
lution (laterally and vertically).

The Scanning Tunneling Microscope was developed by Gerd Binnig and
Heinrich Rohrer in the early 80’s at the IBM research laboratory in Risch-
likon, Switzerland. For this revolutionary innovation Binnig and Rohrer
were awarded the Nobel prize in Physics in 1986.

In the STM, a small sharp conducting tip is scanned across the sample’s
surface, so close that the so-called ‘tunneling current’ can flow. With the
help of that current the tip-surface distance can be controlled very precisely.
Therefore an enormous resolution is achieved so that the atomic arrange-
ment of metallic surfaces can be ‘probed’.
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To be able to get such excellent pictures of atomic resolution is almost
incredible, considering that the size of the atom in relation to the tip is that
of a golf ball to a mountain.

Scanning with the easyScan 2 STM

In the easyScan 2 STM, a platinum-iridium tip is moved in three dimen-
sions using piezo-crystal translators that are driven with sub-nanometer
precision.

Sample holder

Backward scan

I

Forward scan

The sample to be examined approaches the tip within a distance of 1
nanometer (1nm=1/1 000 000 000 m). Classical physics would prohibit
the appearance of electrons in the small gap between a tip and a sample, but
if a sharp tip and a conducting surface are put under a low voltage
(U~0.1V) a very small tunneling current (I~1nA) may nevertheless flow
between tip and sample. This tunneling current is due to a quantum phys-
ics effect.

The strength of the tunneling current depends exponentially on the dis-
tance between the tip and the sample (usually referred to as Z-distance).
This extreme dependence on the Z-distance makes it possible to measure



SCANNING WITH THE EASYSCAN 2 STM

the tip-sample movement very precisely. One of the three piezo crystals, the
Z-piezo, can now be used in a feedback loop that keeps the tunneling cur-
rent constant by appropriately changing the Z-distance.

Feedback loop: The feedback loop maintains a constant tunneling current between the tip and the
sample during motion in the X-direction by changing the Z-direction (viewed from top)

To obtain an image of the sample, the tip is scanned using the X- and Y-
piezo crystals. The feedback loop will now let the tip follow the structure of
the sample’s surface. A height image can now be made by recording the
position of the Z-feedback loop as a function of the XY-piezo position. This
‘landscape’ (or topography) of the atomic surface is then drawn line by line
on the computer screen.

The sample can also be scanned in a second mode: When the feedback loop
is slowed down very much, the tip scans at a fixed distance from the sample
(constant height mode). This time the variations in the tunneling current
are measured and drawn line by line on the computer screen. However, this
mode only works when the sample is atomically flat, because the tip would
otherwise ‘crash’ in to the sample.
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